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Creating prescriptions and managing medications

InWolf EMR, you can create and print prescriptions from any window related to a patient's record (via
the SMART menu).

Once a medication has been prescribed for a patient, you can:

Reprint the prescription

Modlify the prescription

Refill the prescription

m Discontinue the prescription

Wolf EMR tracks a patient’s active (current) and inactive (previous) medications in the medical
summary, and displays the patient's medications and allergies in the Prescription entry window. This
allows you to view pertinent information at-a-glance when you prescribe new medications.

Creating prescriptions

You can prescribe a medication from almost any window related to a patient via the SMART menu.
Wolf EMR contains an extensive searchable medications list, enabling you to quickly select an
appropriate medication to prescribe.

You can enter prescription directions using discrete entry fields (for example, for dose, frequency,
and duration), or you can enter prescription directions as free-text. Using a variety of search and entry
options, you can create:

m Basic prescriptions (see "Creating basic prescriptions" on the next page)
m PRN prescriptions (see "Prescribing PRN (take-as-needed) medications” on page 16)

m Prescriptions for compound medications (see "Prescribing compound medications” on
page 17)

m Variable dose prescriptions (see "Prescribing variable doses" on page 18)

m Prescriptions for medical devices and other non-medication treatments (see "Prescribing

medical devices and other non-mediation treatments" on page 19 and "Prescribing medical
devices and other non-medication therapies using SMART Forms" on page 20)
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m Prescriptions for over-the-counter (OTC) and intravenous medications (see "Prescribing over-
the-counter (OTC) and intravenous medications" on page 21)

You can print more than one medication on a single prescription printout (see "Prescribing multiple
medications" on page 15). Additional medications can be new medications for the patient, or refilled
medications.

If you prescribe multiple medications, the EMR tracks the medications in a visible area, enabling you
to review your prescribed medications before printing the complete prescription.

Creating basic prescriptions

\When you create a basic prescription, you search fora medication to prescribe, and then enter
prescription instructions using discrete entry fields (forexample, for dose, frequency, and duration). If
you enter complete dosage information, the EMR can calculate a quantity automatically.

\When you finish a prescription, you can choose to print the prescription or, if you are prescribing
multiple medications, you can also choose to save the prescription.

You can search for a medication to prescribe using one of three methods:
m By medicationname

m By medication category

m By medication by a targeted system for treatment

Steps

1. Open the Add New Medications window: On any window related to a patient’s record (including
the SOAP form, the Consult Letter form, the medical summary, a patient message/Follow up, or
the Patient tab) right-click and then in the SMART menu, click Enter New Medication. The EMR
displays the Add New Medication window, with:

The medication search area located in the top left area of the window.

Alist of your medication favourites displayed in middle of the window.

The patient's weight, age, and allergies displayed on the top right of the window.

The prescription dosage entry arealocated on the bottom of the window.
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2. To search forthe medication by name:
a) Inthe Search field, enter part or all of the medication name.

b) To narrow orexpand your medication search criteria, using the following table, select or
clearfiltering options.

[Option Description )

Starts Displays only medications with names that start with your search term.
with

Contains | Displays medications with names that contain (but do not have to start with)
your search term.

Dose To display only medications that are available in a specific form (for example,
Form ‘capsule”), inthe list, select an option.

Include Includes non-brand-name medications in your search results.
Generic

Include Includes over-the-counter medications in your search results.
oTC

Include IV | Includes intravenous medications inyour search results.
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Tip:
You can change what medication search options are selected for you by
default;

1. Inthe WorkDesk menu, click Configure > Configure Workdesk.
2. Clickthe Medications tab.

Users with administrator authority in VWolf EMR can set medication search
option defaults for the entire clinic. See "Configuring medication preferences "
onpage 54.

a) Press Enter. The EMR displays matching medications in the Select medication from list
area.

Tip:
Medication search

m Inthe medication search results list, if a medication displays more than
once, there are multiple dosage types for that medication. To view the
dosage type and size, click and then hover your cursor over the medication
name. The EMR displays the dosage type and size as a pop-up message.

m YOU can narrow your search results by selecting the form you want the
medication to be in. Forexample, to search for amoxicillin in capsule form,
inthe Dose Form list, click CAP. The search results retum all amoxicillin
options available in capsule form.

m [fyou are searching for an over-the-counter medication, in the Search area,
selectthe Include OTC check box.

m [fyou are searching for a brand name medication, clear the Include Generic
checkbox.

* Best practice: If you are not certain how to spell a medication name, in the Search
field, type only the first three letters of the medication name. Wolf EMR will not
produce accurate search results for misspelled names.

b) Inthe Select medication from list area, click the medication you want.

3. To searchforamedication by category:
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a) Clickthe Drug Gategory Search tab. The EMR displays alist of high-level drug categories.

Search

[ Include Generic
O Include OTC
O Include v

Doze form
<Any=

Search by ATC categories |

) Starts with
(# Cortsing
Favourites Drug Category Search |
Drug  alternative medicines
Category | analgesics
Searchl | anti-infectives

-

anticoagulants
anticonuvulsants
antidepressants

antidiabetic agents
antiemetic/antivertigo agents
antifungals
antihyperlipidemic agents

b) Clickinthe Drug Category Search
the category you want to select. Fo
agents”. The EMR displays that are

c) Scrolldownthelist, and then clickt
sub-categories to the right.

area and then, on your keyboard, press the first letter of
rexample, press "c" for “central nervous system
a of the alphabetical list.

he category you want. The EMR displays associated

Search

[0 Include Generic

3 Starts with Dose form [ Include oTC
(#) Contains =Any= O Include I+
Favourites Drug Category Search | Search by ATC categories |

Druy  antipsychotics
Category  antituberculosis agents

Search.  antiviral agents
anxiolytics, sedatives, and hypnotics
beta-adrenergic blocking agents
biologicals
bronchodilators
cardiovascular agents

central nervous system agents

cephalosporins

» analgesics
anticonvulsants
antiemetic/antivertigo agents
antiparkinson agents
general anesthetics
muscle relaxants
migcellaneous central nervous sy=tem agents
anorexiants

-

Click a sub-category. In the Select
medications classified withinthat s

e) Clickthe medicationyou want.

medication from list area, the EMR displays a list of
ub-category.

4., >To search foramedication by a targeted system for treatment:

Clickthe Search by ATC Categories tab (Anatomical Therapeutic Chemical). The EMR displays alist

of high-level targeted systems.
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Search ) O Include Generic
O Starts.wrth Doze form [ Include OTC
& Contains <Any> [=] O rneudery
Favourites Drug Category Search | Search by ATC categories |
+ Alimentary Tract And Metabolizm -
Search ATC Categary + Antinfectives For Systemic Use

+ Antineoplastic And Immunomodulating Agents

+ Arntiparasitic Products, Inzecticides & Repellents
+| Blood &nd Blood Forming Crgans

+ Cardiovascular System | 4
+ Dermatologicals

+ Genito Urinary System And Sex Hormones

+ Musculo-skeletal System N

m

a) Choose the system you are targeting for treatment. In the Select medication from list area,
the EMR displays a list of associated medications.

b) To narrow your search results to a specific drug category that targets your selected
system, expand a system name. and then select a category.

Search ) O Include Generic
3 Starts with poslion 0 Include OTC
B Exiietis <Any> [=] O ncude v
| Favourites Drug Category Search | Search by ATC categories |
+ Genito Urinary System And Sex Hormones -
Search ATC Categary =l Musculo-skeletal System

+ Antigout Preparations
+ Artiinflammatory And Antirheumatic Products
+ Drugs For Trestment Of Bone Diseases
+ Muzcle Relaxants
+ Cther Drugs For Disorders Of Musculo-skeletal Sys
+ Topical Products For Joint And Muscular Pain
+ Mervous System N

m

c) Tonarmow your search further to a specific drug sub-category that targets your selected
system, expand a category name, and then choose a subcategory.

d) Inthe Select medication from list area, click the medication you want.

The EMR displays the selected medication name in the blue RX field and populates the
prescription details area with default values (if available).
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» If the selected medication has prescription defaults set, the Dose, Frequency,
Duration, PRN, Anticoagulant and Notes fields and check boxes may auto-
populate. You can edit these default values if needed.

Forinformation about how to set and modify medication prescription defaults, see
"Modifying prescription defaults for medications" on page 58.

Using the following table, in the prescription details area (located on the bottom right of the
window), enter or modify the prescription details.

Note: Depending on the medication you choose, several of the prescription detail
» fields may populate with default values. You can edit default values if needed.

Field Description )
Dosage Below Dosage, choose a dosage option (forexample, for a 250mg tablet,
click250). If the option you want is not available, enter the dose in the Dosage
field.
Units Select the dose units. For example, fora 250mg tablet, selectmg.
Route Select the dose route. Forexample, for a tablet that the patient is to take orally,
select PO (per Orally).
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Field

Description

Units/Dose

Below Units/Dose, click the number of units the patient is to take with each
administration. If the number you want is not available, enter a number in the
Units/Dose field (forexample, 1/2,1,ii).

Frequency list

Select afrequency, orto indicate that the patient is to take the medication as
needed, select pr.

Problem

To associate the prescription with a one of the patient's medical summary
problems, inthe list, click a problem.

You can choose only problems that are listed in the patient’s problem list. To
add a problem to the patient’s problem list, select <Add New>.

Duration

Select aduration. If you are having trouble finding the duration you want, inthe
Duration field, start to enter the duration (for example, to find “4 days”, enter
‘4", The EMR takes you to the appropriate area onthe list.

The Duration option you select determines if and when the medication
automatically discontinues. If you expect to refill the medication, click No Cut
Off.

In# Days is selected, then the Single Rx option is selected on the Prescription
window.

Date
Prescribed

By default the Date Prescribed is today's date. To set the prescription date to
another date, enter the date, or to select the date from a calendar, olickﬂ.

Anticoagulant

If this is an anti-coagulation medication that requires regular INR testing, select
the Anticoagulant check box. The EMR displays the prescription, and future
changes you make to the prescription, on the Anticoagulation Summary
Sheet.

The Anticoagulant check box displays only if your medicationis flagged by
the EMR as an anticoagulant.

Notes

.

Enter any additional prescription notes for the patient (for example, “take
immediately following ameal”).

J

6. Review possible drug interactions wamings. See "Prescribing multiple medications" on page 15.

7. Click Prescribe. The EMR opens the Prescriptions window, with:

m [heleft side of the window displaying lists of the patient’s current and medications, and

allergies.

m [heright side of the window displaying the input area for the current prescription’s quantity,
repeats, and duration details.
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Muiti-Select

Medications
Clobazam (Frisium TAB) 10 mg iPQ ghs
Lamotrigine {Lamictal TAB) 150 mg i PO BID
Methylphenidate (Ritalin-SR ERT) 30 mg iPO O

FPrevious Medications: bl

Allergies

*Rx Date:
*Prescribing MOD:

08-Jul-2016 B
Veta Coles, M.D.

(%) May Substitite Generic ) Mo Substitutions

* . Naproxen (Naprelan 375 ERT) 375 mg i PO OD
Rx:

Total Dosage Per Day: 375 mg

“Cuartity: D) Fepests: 0 G;Duraﬁm
Long Term Single Fx
Units: TAB 2 e
*Start Date 08-Jul-2015 5| ?kaged .
o Come In
Mezxt Refill: Chart Requested
Mote: take with food Denied

& Refill Histary
Rleod Refill

) Medication Histary

|Last Refil | Quant |Repeats |Pharm Called |Refil Status |Intisls |

[ Print Medications

prined [

« [
Current Refill (Dbl Click to Delete Prescription Entry):
Medhlame |Quant |Repeats |Nme

The Special Auth button applies only to British Columbia

Q Tip: You can go backto the previous window (New Mediation window) at any time.

Atthe top of the Prescriptions window, click Edit Medication Dosing =

8. Using the following table, enter additional prescription details.

Q Tip: Use your Tab key to jump from field-to-field.

Field Description )

Rx Date Today's date is selected by default. To set the prescription date to another date,
enter the date, or to select the date from a calendar, oliok Z|

Prescribing | If you have prescribing authority in Wolf EMR, your name is selected by default.

MD If you are creating a prescription on behalf of another provider, in the list, select
the provider's name.

May This option is selected by default.

Substitute |t the pharmacist should not substitute another brand, select No Substitutions

Generic instead.
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Field

Description

NO
Substitutions

If the pharmacist should not substitute another brand, select this check box.

Print
Medications

If you want the patient's complete list of active medications to display on the
prescription print-out, select this check box (if it is not already selected),
otherwise, clear this check box.

Q Tip: You can choose if this check box is selected by default. Users

- with administrator authority can enable or disable this default option
foryou. See "Setting prescription printouts to include patient
medication lists by default" onpage 61.

Quantity

Perform one of the following actions

m [0 enter the medication quantity manually, enter the total amount of
medication to be dispensed (for example, the number of capsules).

m [0 have the EMR calculate the quantity for you, enter the duration the patient
is to take the medication for,

If you enter frequency and duration information in the Add New Medication
window; then the Quantity field is already populated with the calculated number
of tablets, applications, etc.

Units

Choose the appropriate guantity or duration units.

Repeats

Enter the number of repeats, or to indicate that you do not want any repeats,
leave the field blank.

Duration

Select one of the following options:

m [0 indicate that the patient will be on the medication for an extended period
of time. select Long Term.

m [0 indicate that the patient to be on the medication only until the prescription
runs out, select Single Rx.

Start Date

-

If the patient is to start taking the prescription on a day other than today, enter a
new start date, orto select a date on a calendar, C|iCKE.

(BC only) If the prescription requires a PharmaCare Special Authorization form, complete the
Special Authorization form (see "Requesting PharmaCare Special Authority for prescriptions (BC
only)" on page 29).

10. Perform one of the following actions:

Giick

m [0 printthe prescription on your default printer, click Quick Print |,

14



Creating prescriptions and managing medications

» To select a printer or fax machine to print from, click Print £ .
m [0 save the current prescription and to prescribe another medication, click Enter New

Medication |~

. See "Prescribing multiple medications" below.

m [0 savethe prescription, and print it later, click Close and Savel EL*]

After the prescription prints, the EMR changes the prescription Status to 'Printed’. The
medicationis recorded in the patient's medical summary, and in the patient’'s Medications list on
the Prescriptions window.

‘ Note: If alocum prints a prescription, Wolf EMR adds the text “Locum For X’ Physician”
> to the prescription print-out.

Prescribing multiple medications

If you prescribe or refill more than one medication during a visit, you can print the medications ona
single prescription printout.

As you prescribe multiple medications, the EMR tracks the medications in the Current Refill area,
enabling youto review your prescribed medications before printing.

Steps
1. Prescribe the first medication. See step 1 in "Creating basic prescriptions" on page 6.
2. Inthe Prescriptions window, perform one of the following actions:

m [0 prescribe a medication that has not been previously prescribed to the patient, click

Add/New ! | . The previous medication is saved and the Add New Medications window
opens. Then, search for the next medication and then enter prescription details.

m [0 re-prescribe one of the patient’s active medications, refill the prescription. See "Refilling a
single prescription (for active medications)" on page 43 to "Refilling a single prescription (for
active medications)" on page 43 in "Refilling a single prescription (for active medications)" on
page 43.

m [0 re-prescribe one of the patient’s inactive medications, resume the prescription. See
"Resuming previous medications" on page 45 to "Resuming previous medications" on
page 45 in "Resuming previous medications" onpage 45.
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3. Toadd additional medications to the prescription, repeat the above step. As each medicationis
added to the prescription, the EMR displays the medication name in the Current Refill area. In the
Medications area, the word Refilled also displays beside the medication’s name.

Mot Select *Ry Dite: 08-Jul-2015 ]
2 7 = Crila Veta Coles, M.D.
Medications . = — O it d_E
***** Refilled™** Interferon beta-1a (Auonex Pref ubstitute Generic ) Na Substitutions tint heclic:
Clobazam (Frisium TAB) 10 mg 1P0O ghs . Naproxen {Naprelan 375 ERT) 375 mg i PO 0D
Lamotrigine {Lamictal TAB) 150 mg iPO BID .
Methylphenidate (Ritalin-SR ERT) 30 mg iPO O
Toal Dossgs Per Day: 375 mg
*ouantity: 0 Repeats: 0 G;Duration
Laong Term
Urits: TAB [=] g
. Okayed
*Start Date: 08-Jul-2015
i E To Come In
Mext Refill: Chart Request(
Mlote: take with food Denied
Previous Medications: !
Haproxen (Haprelan 375 ERT) 375 mg i PO OD =y Refill Histary 7 Medication History
Mext Refil |LastRefil  |Quart |Repeats |Pharm Called |Refil Status |intisls |
‘
Current Refill (Dbl Click to Deg Prescription Entry):
hedhlame |Quant \Repeats |Note
. 1a [Avonex Prefiled Sy 1 UMT(S 0
Allergies: sy

STSERTIZ7S mg 30TAB O

Tip: If you add a medication in error and want to remove it from your prescription,
double click the medication on the Current Refill list.

4. To printthe prescription, click one of the following options:

Quick

m Quick Print ™ |: To print the prescription to your default printer.

» Print 2 : To select a printer or fax machine to print to.

Note: All medications that display in the Current Refill area on the Prescriptions
» window are included in the printout.

Prescribing PRN (take-as-needed) medications

Whenyou prescribe a PRN (take-as-needed) medication, forexample, a pain medication oran
inhaler, you do not need to specify a dose, frequency, or duration as long as you enter a guantity. If
needed, in an open-ended text field, you can enter detailed information such as:

= Inwhat situations or cases patient is to take the medication
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m \What dose should be administered depending on the situation
m [he maximum amount of medication the patient can take in a day

= [he minimum amount of time required between doses

Steps

1. Searchforand select a medication to prescribe. See step 1 to step 2 in "Creating basic
prescriptions” on page 6.

2. Onthe Add New Medications window, click OverRide (located below the blue Rx field). The EMR
enables you to edit text in the blue Rxfield.

3. Inthe Rxfield, click to the right of the medication name, and type PRN, followed by prescription
directions. Directions can include:

m Circumstances inwhich the patient is to administer the medication
m Maximum dose perday

m Minimum amount of time between doses

LS 1= ) P P

*Rx 1L SOLN} mL ilINH (lg -PRN ta?e 1.2 puffs for acute asthma symptoms, and prior to exercise
(#)  OverRide Total Dosage P it mL [ &uto save medication s favourite on exit

Do not erase or modify the medication name that is populated by the EMR.

4. Optionally, enterinformation in the dose, units, and frequency fields and complete the
prescription. See step 5 in "Creating basic prescriptions” on page 6.

Prescribing compound medications

Compound prescriptions are medications comprised of two or more ingredients that are combined
by a pharmacist before dispensing. The multitude of potential compound ingredient combinations
are not specifically available in the Wolf EMR's drug database.

Because you cannot select the whole compound from the medication search list, you instead search
forthe firstingredient. You can then customize the Rx name to include the remainder of the
compound ingredients.

Steps

1. Startaprescription as normal, and search for the first compound ingredient. See step 1 in
"'Creating basic prescriptions" on page 6.
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2. Below the blue Rx field, click OverRide. The blue Rx field becomes editable.

3. Inthe Rxfield, click to the right of the firstingredient's name, and then enter the remainder of the
compound ingredients as you want them to display on the prescription.

LA =1 ) P

*Rx _ Hydrocortisone 1% cream/equal part nystatin for 1 application 4x dailyl
(¢}  OverRide Total Dosage Per Day: [ Auto save medication as favourite on exit

[ Inchude Generic

‘ ‘ Note: The name of the first ingredient must remain as is. You cannot edit it.
>

4. Inthe Rxfield, beside the compound name, you can also enter your prescription directions.

5. Optionally, enterinformation in the dose, units, and frequency fields and complete the
prescription. See step 5 in "Creating basic prescriptions” on page 6.

Note: Compounds are not checked for interactions or low/high dosages since
> these prescriptions are entered in as text only.

Prescribing variable doses

Variable dose prescriptions are prescriptions where dose changes from week-to-week, day-to-day,
orwithina day. Some examples include:

m \Weening a patient off of a medication by reducing their daily dose each week.

m [nstructing a patient to take one capsule in the moming than two capsules inthe evening.

These types of prescriptions often have extensive instructions that require greater flexibility for
entering.

* Best practice: Select the most basic version of a medication name. If possible, do not
select a medication with a pill/capsule/application size specified init's name.

Steps

1. Searchforand select amedication to prescribe. See step 1 to step 2 in "Creating basic
prescriptions” on page 6.

2. Below the blue Rx field, click OverRide. The blue Rx field becomes editable.
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3. Inthe Rxfield, click to the right of the medication name, and then enter the prescription directions.
Forexample, “Tapering - 8tabs x 1 day; 7 tabs x 1 day...”

*Rx  Phenobarbital (Phenobarhital TAB) - Tapering - 100mg i PO OD % 10days, then 60myg iPO 0D xl

(&) OverRide Tatal Dosage Per Day:  myg [ Auto save medication az favourite on exit

[ Include Generic

4. Leave the Dose, Units, and Frequency fields blank.

5. Complete the remainder of prescription as you do for a basic prescription. See step 7 in
"Creating basic prescriptions" on page 6.

Prescribing medical devices and other non-mediation treatments

You can create prescriptions for a number of non-medication treatments, including injections,
therapies, and medical devices. If your clinic has added common non-medication treatments to your
EMR'’s medication database, when you create a prescription, you can search for non-medication
treatments similar to how you search for medications. If the treatment you want is notin the
medication database, you search for “Non Medication”, and then you can modify this name to
indicate the treatment.

Tip: For information about how to add non-medication treatments to your EMR'’s
— medication database, see "Adding custom treatments to the medicationlist" on
page 63.

Steps
1. Openthe Add New Medications window. See step 1 in "Creating basic prescriptions" on page 6.

2. Inthe Search field, type part or all of the treatment name (for example, “Brace”), and then press
Enter. The EMR displays a list of matching treatment/device options in the Select medication
from list area.

* Best practice: Type only one word as your treatment search term, as the EMR is more
likely to find a match. Forexample, enter “brace” instead of “carbon fiber knee brace.” You
can then select a more specific description from the resulting search list.

3. Clickthe appropriate device/treatment. The EMR displays the medical device/treatment namein
the blue Rx field.

4. Ifthe search produces no matches for the treatment you want:
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Inthe Search field, enter Non Medication, and then, on your keyboard, press Enter.

a)

In the Select medication from list area, click “Non Medication”.

*Fx  Non Medication

1 CwerRide Total Dozage Per Day: O Auto save medicstion as favourite on exi
Se . [ Include Generic
o [ Starts.wrth Doze form [ Include OTC
Non Medication (s Cortains <Ay [ Include Iv
| Favourtes Drug Categary Search I Search by ATC categories |

Rx Hame
Hon Medication

Description

Favourite Description |Dura

Select medication from list

Hun Medication

Trade Hame

Dose Form Dosage L

Mone

D) Inthe blue Rxfield, enter the treatment name beside the words "Non Medication": Click
OverRide, and then the blue Rxfield becomes editable.

L

*Hx

&) CwerRide Tatal Dosage Per Day:

Non Medication - Carbon fiber knee brace (Left)

5. To free-type your prescription directions, click OverRide and then, in the Rx field, beside the
treatment name, enter your directions (for example, carbon knee brace - to be wom during
weight-bearing following ACL surgery on the right knee).

6. Optionally, enterinformationin the dose, units, and frequency fields and complete the
prescription. See step 5 in "Creating basic prescriptions” on page 6.

Prescribing medical devices and other non-medication therapies using SMART Forms

If you want a printed prescription for a medical device, therapy, and other non-medication treatment
to contain your clinic logo and other customized features, you can use a customized SMART Form
as your “prescription pad”. Before you can prescribe using this method, you must create a custom
SMART form for prescriptions. For details onhow to create custom SMART forms, see the Wolf EMR

SMART Form User Guide.



http://www.wolfmedical.com/helpfiles/SMART_Forms_User_Guide.pdf
http://www.wolfmedical.com/helpfiles/SMART_Forms_User_Guide.pdf
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Steps

1. Onany window related to the patient, (including a patient's medical summary, SOAP form,
Consult Letter Examination form, or Patient tab [CPP)), right-click and then, in the SMART menu,
click SMART Forms. The Send to SMART Form window opens.

2. Intheleft pane, expand Letters. The EMR displays a list of letter SMART Forms.

3. Inthelist, double click Physio Chiro Massage Referral (or the name of your clinic’s customized
prescription SMART Form). The your prescription template opens in Microsoft Word.,

4. Inthe Word document, enter the device or treatment prescription details.

5. Toprintthe prescription, in the Printer list, select a printer and then click Print = The prescription
prints, and the EMR saves a copy of the printed prescription in the Documents tab on the
patient’'s medical summary..

Important : On the Microsoft \Word menu, click File > Print.

* Best practice: Use SMART forms only for NON-MEDICATION prescriptions. Always
enter prescriptions for medications in the Add New Medications window. This way, you
can easily reference, re-prescribe, and flag prescribed medications for possible

interactions.

Prescribing over-the-counter (OTC) and intravenous medications

InWolf EMR, over-the-counter (OTC) and intravenous medications are categorized differently than
other medications, and by default do not display in medication search results. Before you search for
an OTC orintravenous medication, you must indicate that medication search results can contain
OTC orintravenous medications.

Steps

1. Openthe Add New Medication window. See step 1 in "Creating basic prescriptions” on page 6.

2. Inthe Search area, select the Include OTC check box, or the Include IV check box depending on
the type of medication you are prescribing.
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Ry
) Total Dozage Per Day: ave lmedication as favourite on exit
Search ) Starts with Dose farm

(& Contains <Ay E| [ Incluce v

Favourtes Drug Category Search | Search by ATC categories |

Tip: If youwant Include OTC and Include IV to be selected by default, users with
— administrator authority can change configuration \Wolf EMR to have these options
selected by default. See "Configuring medication preferences " on page 54.

3. Searchforthe medication and then complete the prescription as normal. See "Creating
prescriptions” on page 5.

Recording externally prescribed medications

If you want to record that a patient is taking, orhas previously taken, a medication but you do not want
to prescribe the medication at this time, you can record the medication as an extemal medication.

The quickest way to record extemal medications is by using Quick Entry. Quick Entry allows you to
record only basic medication information; you are not required to enter any details about the dose,
freguency, duration, and so on. You are only required to search for and select the medication, orto
manually enter the medication name if it is a compound.

Note: You cannot print extemal medications. Instead, you must refill the prescription and
» then printit. See "Refilling prescriptions" on page 43.

Steps

1. Onany window related to a patient’'s record, right-click and then in the SMART menu, click Quick
Entry. The Quick Entry Form window opens.

2. Clickthe Medications tab.
3. Ifthetreatmentis available in the Wolf EMR medication database:
Inthe Search field enter part or all of the medication name, and then press Enter.

a) Inthelist of matching medications, click the medication you want. The selected medication
populates the Rx field. The EMR also displays dosage, and frequency entry fields.
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Quick Entry Form
Enter Medical History For: Test, Mother [t
petient: 185t Mother Cliric: W Janiva S, MD Phi FRCPC [=]
Social | Problems Medications Allergies | Procedures & Surgeries
Fx Ramipril (Aace oral capsule)1.25 mg i PO 0D
Search (] @ Overfidk Current Medications
Selact madication from i Lipitar
. Melstonin & mg PO ghs
Cassge: UniteiDose:
Salact 35 PEG T350 10 gm po od
128 1 PO [=] Topiramate (Topamax) 25 mg i PO B0
() None () Mone O pm
CE— - -
25 0 [T
5 mi m
10 L @ 1 an
18 mog O SxiDay
magimL qih
mgsmL o ash
wimL qgh
u &) W m2h
n ghes.
—_— £ . Star Dete: | 23.May-2017| 55|
Praoblem: [=1 DG Dot £I
Defsult Phamacy; [i]

b) Optionally, enter dosage and frequency information.

Note:
» If your clinic has prescription defaults set up for the treatment, the dosage and
frequency fields populate automatically. You can modify this information as needed.

If you do not want any dosage and frequency information included, click OverRide,
and then, inthe Rx field, beside the treatment name, delete the directions.

Q Tip: When you refill the prescription later, the dosage and frequency information you

— record here will populate the prescription automatically. Recording the information
now will save you time later.

4., Ifthe treatment is a compound medication, or another treatment that is not available in the Wolf
EMR medication database, click OverRide and then, in the Rx field, enter the treatment name,
and optionally any prescription directions.
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Quick Entry Farm
Erter Medical History For: Test, Wother i+
ratiers.  1@8t, Mother i MCx Janna 5, MD Phil FRCPC [=]

Suu’al: Problems Medications | Allergies | Procedures & Surgeries

Rt Hydrocorizons 1% cresmiscual parl nystalin soply 4: dahll

Search @ Overfide: [ CorreEnt Medications:
Sakct medcation Trom Ik | |
Lipitar
Salact > Melatonin$ mg PO ghs
PEG 3350 10 gm po od
Ramipril (Altace oral capsula)
Topiramate (Topaman) 25 mg il PO BID

StartDate  23-May-217 5|

Frablem O Db ‘_-l

Di=dmuit Pharmacy: [=]

5. Toassociate the treatment with one of the patient’s listed problems, in the Problem drop-down,
select the problem. Orto add a problem to the patient’s problem list, and then associate the
treatment to the new problem, select <<Add New>>.

6. To setadefault pharmacy for this treatment, in the Default Pharmacy list, select the pharmacy.

7. Inthe Start Date field, enter the date the patient began taking the medication. The field defaults to
today’s date.

8. Ifthetreatmentis a previous medication that should display in the patient’s Previous Medications
list, in the D/C Date field, enter the date the treatment was discontinued.

9. ClickSelect >>. The medication is added to the patient’s medications list.

Managing interaction warnings

Whenyou prescribe or refill a medication, the EMR checks the medication against the Cemer Multum
database for:

m Drug-to-allergy interactions (with allergies and intolerances listed in the patient’s Active Allergies)
m Drug-to-drug interactions (with drugs listed in the patient’s Active Medications list)

m Drug-to-condition interactions (with conditions listed in the patient’s Problems list)
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* Best practice: If a patientis no longer taking a medication, but the medication is listed
inthe patient’'s Active Medications list, always discontinue the medication. This way, you
will not receive interaction wamings against irelevant medications.

Important : The EMR does not check for high orlow dosages. Forexample, if you
prescribe a medication dose that is too high for the patient’s weight or age, you are not
notified.

If any interactions are found, you may be prompted with a pop-up waming. You can configure the
EMR to not display pop-up wamings, and instead allow you to manually check for interaction
wamings. You can also configure the EMR to not check for interactions at all. See "Configuring
medication preferences " on page 54.

\When you receive an interaction waming, the EMR lists a summary of drug interactions and then
provides full details about the interactions.

Steps

1. Selectamedication to prescribe, and then record any dose, frequency and duration directions.
See step 1 in"Creating basic prescriptions" on page 6.

2. Ifyour EMRis configured to not display interaction wamings as pop-up notifications, at the top of

the Add New Medications window, click Multum M If interactions are found, the EMR opens
the Drug Interaction Wamings window, containing a list of all identified interactions, followed by
complete details about the interactions. If your WorkDesk is configured to display interaction
notifications automatically, as soon as you select a medication to prescribe, if the EMR identifies
any interactions, the Drug Interaction VWWamings window pops-up.
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Drug Interacion Wamings e
Divuig Il eracion
Summary:

= Moserate Drug Interaction Involving amoxicillin (Amoxil)
- Moderate Dwg Interaction Involving food

MODERATE DRUG INTERACTION
[Batwean warfann (Cowmadin TAR) and amoicillin (Amoxil)

BADMITOR: Penicilline may occasionally potentiste the risk of bleeding in patients treated with oral anticoagulants. The exact
mechanism of inlaraction is unknown but may involve panicillin inhibition of platelat aggregation. In one study, defective platelat
aggregation pecured with predictability in patiers receming penicillin 3 24 million untsday, ampicilin 300 rmgkgiday, and
methicillin 300 mykday. Ciher penicilling such as nafcillin, piparacilling and ticarcillin have also been found to affect platedst
function, and benzylpanicillin and carmenicillin have been raported 1o increase bleading fimes and cause bleading in the ahsence of
an anbcoaqulant, There have been case repons describing increases in prathrombin time and INR a5 well a8 spomaneous bodismg
and bleading in anticeagulated patients following initiation or completion of penicillin therapy. Although most cases have ivobed
larpa, miravanous doses of same paniciling (e.q., carbenicillin, panicillin G, ficarcilling, the inleraction has also bean reparied with
regular, oral doses of amoxicillin and amoxicillin-clavulanate. In fact, a case-control study found amoxicillieclaadanate 1o be one of
anly two rmadications to significantly increass the risk of ovaranticoagulation in previously stable outpatients treated with
phenprocoumnan ar acenocoumarnal. In that study, 300 outpatients at a MNetherands anticoagulant climc who presented wih an IR
value greater than or egual to 6.0 (median value B.8) were compared with 302 randomly selected matched cordols with INR values
within the targst range (meadisn walus 3.2), snd changes in the use of B7 potentially interacting drugs ar drug classes in the for
waeks prior to the index day ware wdentified and analysed A course of amowicillin-clavlanate increased the risk of
avaranticoagulation even after sdjustrent for potential confounding factors, paticulary in patiens treated with acenocournarsl A
followeup stedy focusing on antibiotic use in oulpstients treated with phanprocoumon or scenocournarsl &t & diferent Methedands
arbcoagulant clinic alsa iderified amaxicillin use as a nsk factor for avaranticoagulation, with the relative nsk most stronghy
mcreasad four days or rmone after sta of the antibiotic. MAMAGEMEMNT. Caution is recornmended if a penicillin is prescrbed
durng oral anticoagulant tharspy, especially in the alderly and patients with urasmia or hepatic impairment. The INR should be

e T Rs0n (RO
|

3. Using the following table, manage any interaction wamings.
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(To dothis...

Complete the following steps...

Continue to prescribe the medication despite the
waming(s)

Perform one of the following actions:

m [0 record areason for continuing with
the prescription, in the Override
Reason (optional) field, enter your
reason, and then close the window.

m [fyoudo notwantto enteran overde
reason, close the Drug Interaction
Wamings window.

You can now continue on with the
prescription.,

Prescribe an altemative medication

1. Closethe Drug Interaction Wamings
window.

2. Inthe Add New Medications window,
search foranew medicationto
prescribe.

Discontinue the medication that interacts with the
medication you are prescribing

1. Closethe Drug Interaction Waming(s)
window.

2. Right-click the Add New Medications
window and then, in the SMART menu,
choose View Medication List.

3. Discontinue the medication. See
'‘Discontinuing medications” on
page 40.

4. You cannow prescribe the medication
without aninteraction.
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(To dothis... Complete the following steps... h
Remove an allergy orintolerance from the 1. Close the Drug Interaction Waming(s)
patient’'s Active Allergies list (forexample, window.
because the allergy or intolerance is 2. Right-clickthe Add New Medications

unsupported, orwas recorded in error) window and then, in the SMART menu,

choose View Medical Summary.

3. Inthe Current Hx tab, in the Allergies
area, double-click the allergy you want
to remove. The selected allergy opens
inthe Allergy List window.

4. Inthe Clinical Status list, select one of
the following options:

m Resolved
m Refuted
m Terminated and Reclassified

5. Optionally, inthe Note field, enter your
reason for removing the allergy.

Adverse Reaction
acetaminophen containing compo

Clinical Status: Refuted

[k ]

Centainty: Suspected
Reaction Adverse Reaction
Symptoms: abdominal pain

Date hoted. 23-May- 2017

6. Click Save & Closel ¥¢.

7. Youcannow prescribe the medication
without an interaction.

Stop the prescription 1. Close the Drug Interaction Waming(s)
window.
2. Close the Add New Medications
L window. )

After the prescription is saved. The EMR displays your over ride reason(s) in the patient's Medication
Profile. See "Viewing a patient's medication profile" on page 37.
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Requesting PharmaCare Special Authority for prescriptions (BC only)

InWolf EMR, you can complete and print the PharmaCare Special Authority Request form as you
enter a prescription (via the Prescription window). You can also print the form for a previously entered
prescription.

The EMR completes a majority of the form for you, requiring that you only:

m Select the Indication For Special Authority

m Enter specified details for special authority

Note:

*» PharmaCare Special Authority grants full benefit status to a drug, medical supply or
medical device that otherwise would not be covered or only partially covered. Coverage
is provided for patients with specific medical circumstances and the actual
reimbursement depends on the patient's PharmaCare plan rules, including any annual
deductible requirements.

Forthe patient to receive coverage, they must ensure that Special Authority approval is in
place before they purchase the prescription. Coverage is not provided retroactively.

Steps

1. Search foramedication to prescribe, and then enter any prescription directions. See "Creating
pasic prescriptions” on page 6.

2. Perform one of the following actions:

m [fyouareinthe process of entering the prescription, at the top of the Prescriptions window,
Spec

click Spec Auth Auth |,
= [fyouwantto printa Special Authority form for a previously entered prescription, open the

Spec

Medication Profile window, click the medication, and then click Spec Auth #uth |,

The BC Reference Based Pricing Special Authority Form window opens.
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3 Pharmacare BC

BC Referance Based Pricing Special Authority Fomm

Cuick
[L* Erird 5

Indication For Special Authority

B Treatment Falure on Refersnce Product !
[ Adverse Reaction to Reference Product
O DrugTrug Inberaction with Reference Froduct

O caher Patient Specific indications

Specified Detals

3. Inthe Indication For Special Authority area, select an option.

4. Inthe Specific Details area, enter detailed information regarding the reason for special authority

5. To printthe Special Authority form, perform one of the following actions:

L= [N
= [0 printthe form on your default printer, click Quick Print ﬂ

» To print the form on another printer, click Print € . The EMR displays a printer selection
window. Click the printer you want, and then click Print.

The EMR prints the official provincial form with all fields completed.
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Reprinting prescriptions
If a patient loses or forgets their prescription, you can re-print the original prescription at any time.

Steps

1. Onany window related to the patient's record, right-click and then, in the SMART menu, click
Refill Medications. The Prescriptions window opens.
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2. Onthe Prescriptions window, in the Rx Date field, enter the date of the original prescription, or to
select the date on a calendar, click@. The EMR displays all medications prescribed onthe
selected date in the Current Refill area.

Tip:
@ If you do not know the date the original prescription was created, you can view the
start dates of the patient’s current medications in the Medication Profile.

To view a patient’'s Medication Profile, on the Prescriptions window, right-click and
then, inthe SMART menu, click View Medication List. The EMR opens the patient’s
Medication Profile, with a list of the patients current medications and corresponding
starttimes displayed in the Medications area.

3. Optionally, modify any of the listed medications’ prescription details. See "Editing prescriptions”
onpage 39.

4. To printthe prescription, click one of the following options:

cCaick

m Quick Print ™ |: To print the prescription to your default printer.

» Print £ To select a printer or fax machine to print to.

Medication favourites

If you prescribe certain medications frequently, you can add these medications as favourites. \When
you prescribe favourite medications, you can simply choose the medication in your favourites list and
the EMR populates the prescription directions automatically. You can then make modifications to the
prescription directions as needed before printing the prescription.

Medication favourites also enable you to reduce the amount of time it takes to produce prescriptions
with long or complicated details (for example, tapering medications and compound medications)

You can make medication favourites for yourself, or you can make medication favourites that any
prescriberin the clinic can use.

Adding medication favourites

\Whenyou create a prescription, you can add the prescription to your list of favourites at any time
during the process. The selected medication, as well as any prescription directions you have entered




are saved as part of the prescription favourite. |
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Note: Medication favourites can only be created for one medication at a time. You

»

cannot create a favourite that includes multiple medications.

Steps

1. Starta prescription as normal, and enter any prescription directions in the Add New Medication
window. See step 1 in "Creating basic prescriptions" on page 6.

Note: Only prescription details entered in the Add New Medications window save

»

as part of the favourite.

2. Inthe middle of the window, click the Favourites tab (if not selected already).

3. Inthe Description field, type a name for the medication favourite.
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check box.

To make the medication favourite available to all providers inyour clinic, select the Clinic-wide

Click Add Favourite. The medication displays inyourlist of favourites.

6. Complete the remainder of prescription as you would for a basic prescription. See step 7 in
"'Creating basic prescriptions" on page 6.
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Creating prescriptions using favourites

If you have user-specific or clinic-wide medication favourites, when you prescribe a medication, a list
of your favourites displays on the Add New Medications window, in the Favourites area. In the list of
favourites, you can double-click a favourite to prescribe it. If your list of favourites is extensive, you
can filter the list by entering a search term in the Search field.

Steps
1. Openthe Add New Medications window. See step 1 in "Creating basic prescriptions” on page 6.
2. Clickthe Favourites tab (if itis not selected already).

3. Inthe Search field, type all or part of the medication name or favourite description, and then press
Enter. In the favourites area, the EMR displays only matching medication favourites.

: T STaE L Dozeform D Include OTC
Cipro (® contains <Any> =] O neheer
‘ Favourites Drug Category Search | Search by ATC categories |

Rx Hame 1
Ciproflaxacin (Cipro TAE} 500 mg 1P0 BID J

Vi
i
Select medication from list Problem: =
i | Trade Hame |Dase Form Dosags Uritsose *Durstion [+]
. - prc 2 *Date Prescribed: 09-Jul-2015 | ]
ipro
Cip PWDR & M & Nore 0D
Cipro TAB o |
Cipro XL ERT @®mw 0
Cilaxan SOLH ol
Ciloxan OINT @ i | SeDay
asone ofic  Ciprodex SUSP ath
@ i gqbh
o ash
Units @& i qizh Nates:

4. Double click the favourite you want. The EMR populates the Rx and prescription direction fields
with the medication favourite default information.

5. Modify the prescription details as needed, and complete the remainder of the prescription as
normal. See step 5 in "Creating basic prescriptions” on page 6.

Managing your favourites
You can manage your list of prescription favourites by:

m Modifying the order of yourlisted favourites (see "Modifying the order of your favourites” on the
next page)

m Editing the description and share settings of favourites (see "Modifying medication favourites” on
the next page)

m Removing favourites (see "Removing favourites" on page 36)
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All favourite management options are available right from the Add New Medications window, on the
right side of the favourites area.

Modifying the order of your favourites

If you have numerous favourites for one medication, with each having different dosage directions,
finding the medication favourite you want can be cumbersome. For this reason, you can modify the
order of your medication favourites list so that favourites with the most commonly prescribed dosage
directions display higher on thelist.

Steps

1.
2.
3.

Openthe Add New Medications window. See step 1 in "Creating basic prescriptions" on page 6.
Clickthe Favourites tab (if it is not selected already).

Inyour list of medication favourites, click the favourite you want to move.

Tip: If your medication favourites list is extensive, in the Search field, enter all or part
-~ of the medication name or favourite description, and then press Enter. The EMR
displays only matching favourites.

Ontheright of your medication favourites list, click either Move Up in Favourites List *| orMove
Down in Favourites List ¥ The EMR moves the prescription favourite up or down a level.

Continue to click the arrow until the medication favourite is located where you want.

If you are not creating a prescription at this time, at the top of the Add New Medications window,

click Gancel x . The EMR closes the Add New Medications window, and saves the
modifications you made to your favourites list.

Modifying medication favourites

After you add a medication favourite, you can later modify the favourite’s description or share
settings. You cannot modify the medication name or prescription details. If you want to edit the
medication name or prescription details, you must remove the favourite (see "Removing favourites”
onthe next page), and then add a new favourite (see "Adding medication favourites" on page 32).

Steps

1.
2.

Openthe Add New Medications window. See step 1 in "Creating basic prescriptions" on page 6.

Clickthe Favourites tab (if it is not selected already).
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Tip: If your medication favourites list is extensive, in the Search field, enter all or part
of the medication name or favourite description, and then press Enter. The EMR
displays only matching favourites.

Inyour list of medication favourites, click the favourite you want to modify.

To the right of your medication favourites list, click Edit ﬂ The Edit Favourite window opens.

To editthe description for the medication favourite, in the Modify the description field, modify the
text displayed.

To change the share settings for the medication favourite, click one of the following options:

m Personal: To make the favourite available on your list only.
m Clinic Wide: To make the favourite available to all clinic users.

If you are not creating a prescription at this time, at the top of the Add New Medications window,

click Cancel ot . The EMR closes the Add New Medications window, and saves the
modifications you made to your favourites list,

Removing favourites

If youno longer use a certain prescription favourite, you can remove it from your list. Removing
unnecessary favourites keeps your favourites listlean and easy to use.

Steps

1.
2.
3.

Openthe Add New Medications window. See step 1 in "Creating basic prescriptions" on page 6.
Clickthe Favourites tab (if it is not selected already).

Inyour list of medication favourites, click the favourite you want to remove.

Tip: If yourmedication favourites list is extensive, in the Search field, enter all or part
of the medication name or favourite description, and then press Enter. The EMR
displays only matching favourites.

To the right of your medication favourites list, click Remove Drug from Favourites x . The
favourite is removed from your list,
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5. Ifyouare not creating a prescription at this time, at the top of the Add New Medications window,

click Gancel et . The EMR closes the Add New Medications window, and saves the
modifications you made to your favourites list.

Viewing a patient’s medication profile

Ina patient's medication profile, you can view at-a-glance the patient’s current and previous
medications, and current allergies and intolerances. For each medication, you can view:

m [he patient’s current prescription directions

m Ahistory of refills and prescription direction edits for the medication

Steps

1. Onany window related to a patient, right-click and then, inthe SMART menu, choose View
Medication List. The Medication Profile window opens, and displays the patient’s:

m Current (active) medications
m Previous medications

m Allergies

2] Medication Profile E=n[F=RIF3
Test, Mother PHAS990234122 D/C
3 INR Lod | ped refil | | & o< Q¢
Eorn OB-Mar-4975 (42 yr} SeF Stotushiih
123 Test Street, H P danna Schreiber, MD Ph.
Olds 4B T1F OE1 C Detautt Pharma
% et Susan M. Kuhn

Effactive (a5 of) Date: 23-May-2017 | |

Current Medication

Medications
Medication Name Start Date Atorvastatin (Lipitor oral tahlet) 10 mg i PO OD
Atorvastatin (Lipitor oral tablet) 10 mg iPO 0D 23-May-2017
Hydrocortisone 1% creamJequal part nystatin apply 4x daily 23-May-2017 rap— E
Lipitor 23 May-2017
Melatonin5mg PO ghs 05-Mar-2012 Start Date: 23-May-2017
PEG 3350 10 gm po od 05-Mar-2012 End Date: Ho Cut Off
Ramipril (Aftace oral capsule) 23-May-2017
Ramipril (Altace oral capsule) 23 May-2017
Topiramate (Topamax) 25 mg i PO BID 27-Aug-2012 Hote May be taken any time but evening is recommendec

- There are no drug interaction overrides recorded for this medication.
Previous Medications

Medication Hame End Date Start Date - <

Atorvastatin (Lipitor oraltablet) 10 mg iPO  23-May-2017T  23-May-2017 i Linked Lab Results:
Co-topiramate tabs, 26 mg tabs, take 2tabs .  27-Aug-2012  06-Sep-20M1 |=

Melatonin (HA)2mg PO ghs 27-Sep-2010 22 Jun-2009

Melatonin10 mg PO ghs 05-Mar-2012 27-Sep-2010

Ramipril tAftace oral capsule 23-May-2017

Ramipril (Altace oral capsule}

Allergies: @ Refill Histary O Medication History
i Next Refil  Last Refil Quant Repeats |PhCal  RefilStatus | Intials | Motes

23-May-2017 23-May-2017

ipeniciliing

By default, medications are listed in Alphabetical order.
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Note:
» Medications that display on the Active Medications listinclude:

m Short-term medications that the patient is estimated to be currently or recently
taking (based on prescription directions)

m Continuous medications that have not been discontinued (evenif the
medication is completed)

2. Tore-sortthelist so that medications are listed in chronological order by start date, click the Start
Date column header.

3. Toview detailed information about a medication and it's prescription history:

Inthe patient's Medications or Previous Medications lists, click the medication. In the right pane, the
medication’s latest prescription directions are displayed.

If there was an interaction waming for the prescription, and the prescriber entered an override
reason for the waming, the following text displays inred text: “Thereis 1 drug interaction
override recorded for this medication”. You can click this text to view the interaction waming(s)
and the overide reason.

If the patient has any lab results that are linked to this medication, the lab results are displayed
inthe Linked Lab Results area.

a) Toview ahistory of discontinuations, dosage edits, and refills for the prescription, at the
bottom of the window, click Medication History.

_» Refill History riMedication Histary

Prescribed | Dizcontinued| Medicatio
05-har-2012 Melstonin 5
27-Sep-2010 05-Mar-201 2 Melston]
22-Jun-2009 27 -Sep-201 0 Mel

Reason

ghs  Medication reason
O ghz  Medication reason
12my PO Medication reason

b) To view the refill history for the medication, click Refill History.

‘ ‘ Note: \When a prescription is printed or refilled, itis documented in the Refill History.
>

c) Toview any interaction wamings for the medication, at the top of the window, click Multum.
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If the patient is taking an anticoagulation medication (for example, warfarin), you can open the
patient’s anticoagulation summary sheet: At the top of the window, click INR.

To view detailed information about a listed allergy or intolerance, in the Allergies area, double-
clickthe allergy. The allergy opens inthe Allergy List window.

Modifying patient medications and prescriptions

Once a prescription is created, the medication and it's prescription history is recorded in the patient’s
chart (first as an active medication, and then later as an previous medication). From the Medications
list (and in some cases the Previous Medications list), you can:

Edit prescription directions (see "Editing prescriptions" below)
Discontinue medications (see "Discontinuing medications" on the next page)

Record adverse reactions to medications (see "Discontinuing medications due to adverse
reactions" on page 41)

Delete extemal medications (see "Deleting patient external medications" on page 42)

Editing prescriptions

It after you print a prescription you realize there is an error on the prescription, from the Medication
Profile you can edit the prescription details and reprint the prescription. VWhen you edit a prescription,
the previous prescription is moved to the Previous Medications list, and the edited prescriptionis
added as a new prescription.

Steps

1.
2.

Open the patients medication profile (see "Viewing a patient's medication profile" on page 37).

In the Medications area, click the medication you want to edit. The EMR displays the
medication’s prescription details inthe right pane.

Onthe top right of the window, click Edit Medication Dosing & Tre prescription opens inthe
Add New Medications window with editable fields.

Modify the prescription details as needed, and complete the remainder of the prescription as
normal. See step 5 in "Creating basic prescriptions” on page 6.
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Discontinuing medications

\When you instruct a patient to stop taking a medication, you should always discontinue the
prescription in the patient's EMR record. This way, the patient’s active medications list accurately
reflects what medications the patient is currently taking. Also, in keeping a patient’s active
medications list accurate, you will not receive interaction wamings against medications the patient is
no longer taking.

\When you discontinue a medication, you can record any adverse reactions to the medication at the
sametime.

* Note: When a medicationis discontinued, it can still be referenced or refilled from the
» patient's medication mrofile. Discontinued medications are never permanently deleted
from a patient’s record.

Steps

1. Openthe patients medication profile (see "Viewing a patient’s medication profile" on page 37).

2. Inthe Medications area, click the medication you want to discontinue. The EMR displays the
medication’s prescription details inthe right pane.

3. Onthetopright of the window, click D/G Med. The Discontinue Medication window opens, with
the Date Discontinued defaulted to today’s date.

Discontinue: Discontinue
Amoxicillin (Amox CAP)250 mg iPO TID Cancel
Date Discontinued: 4 6-Sep-2014 EI
.
Send KWL ﬂ;llergyl Adverse Bx | Anaphylaxis
Reazon: E|

4., Torecord that the patient stopped taking the medication on a date earlier than today, in the Date
Discontinued field, enterthe date, orto select a date on a calendar, clickﬁ.

5. Inthe Reason list, select a reason for discontinuing the prescription. If the reason you want is not
available, enter your reason in the Reason field.
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6. Click Discontinue. The discontinued medication is moved to the Previous Medications area of
medication profile window.

Discontinuing medications due to adverse reactions

If a patient has an adverse reaction to a medication, you can discontinue the medication and record
the reaction inthe patient’'s medical record at the same time.

Steps
1. Openthe patients medication profile (see "Viewing a patient's medication profile" on page 37).

2. Inthe Medications area, click the medication you want to discontinue. The EMR displays the
medication’s prescription details inthe right pane.

3. Onthetop right of the window, click D/C Med. The Discontinue Medication window window
opens, with the Date Discontinued defaulted to today’s date.

4., Clickone of the following options:

m Allergy

= Adverse Rx

= Anaphylaxis

Discontinue: Discontinue
Amoxicillin (Amox CAP)250 mg iPO TID Cancel

Date Discontinued: 4 6-Sep-2014 EI
.

Send XML Allergy | Adverse Bx | Anaphylaxis

Reazon: E|

The Clinical Records window opens with the medication and reaction type already populated in
the Allergy To area.

41
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Clinical Records

Test, Dq_l_l_qhter

wee ~
Aorn 28-Aug-1999 (15)

FHN 9999 999 999

S B Status S

123 Test Street,
Sojuamizh BC

Ao -
C(222) 222-2222
W

FriWeta Coles, MD.

Certainty:
Reaction:
Symptoms:
Mate:

Drate Moted:

Allergy To:
(& Medication

Clinical Status:

C)Category DVaccine Type Dother

Active [=]
=]

Medication reason

(]

09-Jul-2015 [

5. Using the following table, record the allergy or intolerance details.

Field Description b
Certainty | Inthelist, select one of the following options:
m Suspected: To indicate that an allergy is suspected but not confimed.
m Confirmed: To indicate that an allergy is confirmed.
Severity In the Severity list, select the level of severity the reaction was.
Symptoms | Inthe list, select the symptom the patient experienced. If none of the options are
appropriate, then enter the symptom into the Symptoms field.
Note Enter any additional notes about the reaction. If in the Reaction Type list, you
selected Other, enter the reaction type here.
Date This date defaults to today. If the patient reported the reaction prior to today, enter the
Noted reported date. Use the format DD-MM-YYYY or click the down arrow and select a
L date from the calendar. )

6. ClickSave & Closel L . Inthe medication profile window, the discontinued medication is
moved 1o the Previous Medications area. Allergy is also recorded in the patient’s list of allergies.

Deleting patient externalmedications

If you record an external medication for a patientin error (for example, you record a medication in the
wrong patient’s record), you can permanently delete the medication from the patient’s list of
medications as long has the medication has not been prescribed.

Medications can be permanently deleted only if the medication was not prescribed.

V)
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Steps
1. Open the patients medication profile (see "Viewing a patient’'s medication profile" on page 37).

2. Inthe Medications area, click the medication you want to delete and then, at the top of the

window, click Delete Medication from Record ~< . The following waning window opens.

WARNING [
Are you sure you want to perrnanently Delete: | oK

Brooicillin (B oe oral capsule) 250 mg i PO | Cancal
TiD

From Patient's Medical Recard 7
Please type YES to confirm

m

3. Intheentry field, type YES and click OK. The medication is permanently removed from the
patient’s list of medications.

Refilling prescriptions

If a patient has previously been prescribed a medication, and the medication is listed in the patient's
active or previous medications, you can quickly refill the prescription.

Youcan:

m Refill a prescription from a patient's Medications list (see "Refilling a single prescription (for active
medications)" below)

m Resume a prescription from a patient’s Previous Medications list

m Refill prescriptions for multiple medications at once.

If you refill prescriptions for multiple medications at once, you cannot modify the prescriptions’
directions before the prescriptions are printed. If you are refilling multiple prescriptions, but you want
to modify the prescription directions for one or more of the prescriptions, you must refill the
prescription for one medication at a time (see "Refilling a single prescription (for active medications)”
pelow).

Refiling a single prescription (for active medications)

If you refill a prescription for one medication at a time, you can modify the prescription directions (for
example, dose, duration, and frequency) before you print or save the refilled prescription.
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Steps

1. Onany window related to a patient's medical record, right-click and then, in the SMART menu,
click Refill Medications. The Prescriptions window opens.

2. Inthe Medications area, click the medication you want to refill. The EMR displays the
medication’s prescription details.

3. Tomodify any of the prescription’s dose, frequency or duration details:

Atthe top of the window, click Edit Medication Dosing & The prescription opens in the Add New
Medication window.

a) Moaodify the prescription directions as needed, and then click Prescribe. See step 5 in
"Creating basic prescriptions" on page 6.

4. To refill another prescription:

In the Medications list, click the next medication you want to refill. The EMR displays a dialog box
with the following prompt; “Save [medication name and prescription details] on prescription?.”

a) ClickYes. The EMR displays the word ******Refilled****** in front of the saved medication,
and displays the saved medication in the Current Reéfill area (located on the bottom of the

Prescriptions window).
Prescriptions
Test, Mother FHN 9990234722 DiC Quick
b ECNL @ Multun ted |3 T Pt =R
Sorn 06-Mar-1983 (34 y1) Sex B Skatus NS,
5980 SE Oriental Court, H Frdanna Schreiber, MO Ph... Detault Pharmacy:
Qlds 4B T1F OE1 [
43

R n b, Kuhn EI
Mult-Select XD 26-May-2017 ) |
WMedications il bDQM Zl:hnaiher, Janna Snmt:lr, ;m;:::; FRCPC — dE|at
il ledications
***** Refilled™ Atorvastatin (Lipitor oral tablet) A sURstiLe eneri @ oS

*R Melatonin 5mg PO ghs

PEG 335010 gm po od
Topiramate (Topamagz) 25 mg ii PO BID

Total Dosage Per Day: N/A

*Quiantity: 0 Repeats: 0 *Duration
Long Term Single R:
Units: month = (3 Long ) Single Rx
*Start Date: 26-May-2017 E Eha!’t:equested -
= enie:
Mext Refill: Okayed
Mote: Medication note Pending
Pravious Medications: ! To fame In ad
Atorvastatin (Lipitor oral tablety 10 mg iPO . (= Refill History ¢y Medication Histary

Atorvastatin (Lipitor oral tablet} 10 mg PO
Co-topiramate tabs, 25 mg tabs, take 2 tabs |
Melatonin (HA) 2 mg PO ghs

Melatonin 10 mg PO ghs

Topiramate (Topamax) 125 mg PO 0D X 2w

Topiramate (Topamax) 25 mg iPO BID 4 *
Topiramate (Topamax) 25 mg PO BID Current Refill (Dbl Click to Delete Preseription Entr
Topiramate (Topamax) 25 mg tabs, take 12.5
Taniramata (Tanamay \ & mn i DO RIN & Medhiame Guart | Repeatal
iAtorvastatin (Lipitor orsltablet) 10 mg 18 TAB 0O May heTaken any time but evening is recommer

Allergies
6-mercaptopurine Allergy, Mild

Mzt Reill Last Refill Guant | Repeats Pharm Called  Refil Ststus  Infials
11-Mar-2012  05-Mar-2012 1 month| 5 Yes Printed JEE
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‘ Note: All medications that display in the Gurrent Refill area on the Prescriptions
» window are included in the refill printout.

5. Once select all medications you want to refill, click Save & Closel L . Awindow opens with the
following prompt: “Save [last medication name and prescription details} on prescription?.”

6. ClickYes. Adialog box opens with the following prompt; “Print Prescription”?”.

7. Toprinttherefill, click Yes.

Resuming previous medications

If a patient has previously taken a medication, and the medication is listed in the patient’'s Previous
Medications list, you can easily resume the medication’s prescription without having to re-write the
prescription. Resuming a medication creates a new prescription in the Medications list. The original
prescription remains in the Previous Medications list.

Steps

1. Openthe patients Medication Profile. See "Viewing a patient's medication profile" on page 37.
2. Inthe Previous Medications area, click the medication you want to resume.

3. Atthe top of the window, click Resume. A dialog box opens with the following message: “Refill
<medication name, dose, and frequency> now?”

4. ClickYes. The Prescriptions window opens with:

m [heresumed prescription’s details displayed
m Theresumed prescription listed in the Medications area.

5. Complete the prescription. See "Refilling a single prescription (for active medications)" on
page 43.

Refiling multiple prescriptions at once

If you want to quickly refill several medications at once without changing their original prescription
directions (forexample, if you are refilling a patient’s blister-pack), using the Multi-Select check box,
you can select which medications you want to refill, and then refill all selected medications in one
click. When you refill multiple prescriptions via the Multi-Select check box, you:

= Canrefill only medications listed in the patient's Medications list
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m Cannot modify any of the prescriptions’ dose, frequency, and quantity details

m Must have the same duration of therapy, and refills for all medications being prescribed

To refill medications listed in the patient’s Previous Medications list, or to modify the prescription
directions for a medication you want to refill, you must refill each medication one-at-a-time. See
"Refilling a single prescription (for active medications)" on page 43 and "Resuming previous
medications" on the previous page.

Steps

1. Onanywindow related to a patient's medical record, right-click and then, in the SMART menu,
click Refill Medications. The Prescriptionswindow opens.

click the medications you want to refill.

Above the Medications list, select the Multi-Select check box and then, in the Medications area,

Prescriptions
Test, Er_nmy

. ~
Born 05-Jul-1996 (20 yT} Sex P StatwsMiA

FHN 9996309555 pic

Med g+ Prinit

Quick

=

739 Test Street,
Delia AB WA 14

 (555) 555-5555
© (444) 444-44a4
w

FriJanna Schreiber, MD Ph... Default Pharmacy:

Ret

Multi-Select Refill Selected

Medications
Budesonide turbo (Pulmicort Turbohaler) 200 m
Insulin glargine (rDHA origin) injection (Lantus)
Insulin lispro 18 units $C qam and 20
:Levothyroxine (Synthroid) 112 mcg PO 0D

Terbutaline (Bricamyl Turbuhaler) 0.5 mg i inhal

Prewious Medications: &1

aerochamber -
Amoxicillin (Gen-Amoxicillin CAP) 500 mg 1
Amozicillin 2 gm PO 1 hour prior to procedur
Beclomethasone dipropionate MDI (Quar) 101
Insulin (Humulin M} 140 SC at breakfast
Insulin (Humulin H}16u 0 5C

Insulin (Humulin H}17 u  SC q am

Insulin (Humulin Hy17 u 05C

Insulin glargine (rDHA origin} injection (Lantu
Inzuilin alarnine (FNA Arining iniectinn (0 ant

*Rx Dite: 29-May-2017| 5|
*Prescribing MO Schreiber, Janna Somer, MD PhD FRCPC
(%) May Substitute Generic () Mo Substitutions

*RX Avamys 27.5 my i nasal to each nare OD with URTIs

Total Dosage Per Day: 27.5 mg

HEuantity: 0 Repests: 0 *Dustion
Unit: inh (@ Long Term () Single Rx
Inits: inl
*Start Date: 20-May-2017 | Ehf{ﬂ :Buuested -
enie
Med Refill: Ohayed
Plote: Medication note Pending

Ta fome In

() Refill History (y Medication History

Mext Refil Last Refill Guant  Repests Pharm Called | Refil Status  Intials

08-0ct-2012 1 inh 2 Yes Prirtec JSS

4
Current Refill (Dbl Click to Delete Prescription Entry):

MedMame Guart  Repeats Mote

Print Medications

Modify information in the Quantity field, Repeats field, and Duration area as needed.

Note: Any instructions you add/modify in the Quantity, Repeats, and Duration fields

»

apply to all selected medications.

name and prescription details} on prescription?.”

To printthe refills, click Yes.

click Save & Closel L L .Adialog box opens with the following prompt: “Save [last medication

ClickYes. Adialog box opens with the following prompt; “Print Prescription”?”.
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Managing refill requests from patients and pharmacies

When refill requests come in from a pharmacy, a nurse or MOA can queue the prescription and initiate
a Refill Reguest. The request is sent to the provider for approval before the refilled prescription is sent
packto the pharmacy.

Also, if you are a provider who is too busy to manually enter a patient’s prescription(s), you can
instruct a resident or other clinical staff member to enter the prescription(s) (via a refill request) in
advance of, or during a patient visit. You can then review the prescription, make modifications as
necessary, and then print.

Using refill requests:

m Nurses and other clinical staff members can create and manage refill requests for providers (see
"Sending refill requests to providers (front-end staff)" below and "Managing phamacy callbacks
using the Pharmacies to Call list (front-end staff)" onpage 51)

m Providers can review, approve, modify or decline refill requests (see "Reviewing and responding
to refill requests (providers)" on page 49)

Sendingrefill requests to providers (front-end staff)

\When a pharmacy or patient requests a prescription refill, you can queue the prescription for the
provider. WWhen you finish queuing the prescription, the provider is notified and they can then choose
to approve, modify or reject the queued prescription. From your WorkDesk, you can track and
manage prescriptions that are approved or rejected. See "Managing pharmacy callbacks using the
Pharmacies to Call list (front-end staff)" onpage 51.

Steps

1. From the WorkDesk, in the Data Entry area, click Refill Request. The Patient Search window
opens.

2. Searchforthe patient and then double-click the patient’s name. The the Medication Refills
window opens.

3. Inthe Pharmacy list, select the pharmacy requesting a refill for the patient.

Tip: If the pharmacy you wantis not available in the list, from your WorkDesk, you
= canadd a phammacy. See "Managing your clinic’s phamacy list" on page 53.

a7
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4. Inthe Medications list, click the requested medication to refill. The Réfill History area displays
refill information for the medication.

Q Tip:

— If you do not see the requested medication in the list, you can add the medication.

Atthe bottom of the Medication Refills window, click Add Medication to List al
The Add New Medications window opens.

Enter the prescription directions similarto how a provider would. See "Creating
prescriptions” on page 5.

If you want the refill request to display in the provider's list of refill requests to review,
inthe Prescriptions window, set the status of the prescription to Pending.

* . Warfarin (Coumadin TAB)1 mg iPO OD
Rx:

Tatal Dozage Per Day: 1 mg

*Eusntity: 30 Repests: 0 *Duration

Long Term Single Rx
Units: TAB E| ® ) Sing
*Ztart Date: 11-0ct-2016 E Chart Requested -

’ Denied

Mext Retil: 10-Hou-2016 Okayed -

Mote:
Printed

Tn roame In

=] Madicatian Refill =
Test, Emmy I El_"
k]
- Jul- 1996 {20 yr b wxF Mk e
T3 Tesd Strest, (555) 555-5555 o -Janre =, WO
Deha 88 WiW 1.1 (2494 944-49444
. ~ Rewall Drug
Fhormacy THNEEETE .| - MO Janna & MO PHD FRCPC
Fatiend Agec 20,9

Do of Last Vist  449-Jun-2013

Medications: Rafill

Lewathyr oxing (Synilhioid) 112 meg PO 00
Budesonide turbso (Pulmicort Turbohaler ) 200 mcg i inhalation

e fliricamyd Turbuhaber 5 mg | mbalation g3 prm Rehil H story
SR AL R RNl RefliDue  LastRefl  Quenity |Repests |RefiSistus |Caled
Insulin glargine (rDHA ariging injection (Lantus) 22 units SC ot $-0ct-2012  |1inh 2 Prirbed Yes

Insulin lispro (Hurmalog) 18 units SC qam and 20 u SC at suppes

dp | Add Medication Ta List

5. Enterthe Quantity and then ensure that Duration and Start Date are appropriate.
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6. ClickCloseand Savel A . Awindow opens, prompting you to confirm that you want to save the
prescription.,

7. ClickYes. Awindow opens, prompting you to confirm that you want to print the prescription.
8. Perform one of the following actions:

m [fyouwantto print the prescription for this single medication, click Yes.

m [fyoudo notwantto print the prescription, or if you want to include more refilled medications
onthe prescription, click No.

The EMR retums you to the Medication Refills window.

9. To add additional refills to the prescription, repeat step 4 tot 8.

10. Click Close Forml ﬂ!]

Reviewing and responding torefill requests (providers)

If a front-end staff queues a prescription for a refill request, you are notified on your WorkDesk. From
the WorkDesk, you can view, modify, and respond to your refill requests.
Steps

1. Onyour WorkDesk, in the Refill Requests area, click # Réfills to be Approved. The Prescription
Refill Requests window opens, with alist of pending refill requests.

Preacripkions Refill Reque st
‘ Refill Requests May 29, 2017 G ‘
[Tast, Emmy £ge 204 {903)-932- 344 Reall Beig P micy e O
FPending Foliow i Last Apot 1. Jun203 et At Mot Chart Requested
\Budesenide wirbo (Pulmicon Tuibohalen) 200 =t TN Mesesonnde Olayed
mey | inhalation BID Fepess 0 4
[ Bradad ~ L
Test, Emmy AgE IS {807} 912 1444 Rewall Drug Fharmacy Caled [m]
| S — Lot Appt #1-Jun- 23 Mot Appt Hale ':M't:mmm
lsulin (Humulin Hj 20w SC g am nat 2 e e Heayed

Lr— v [Panding i

[T

Tip: You can quickly view a patient's medical record before responding to a refill
— request. To open a patient's medical summary, on the refill request list, click the
patient's name.

2. Using the following table, respond to each refill request.
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patient is to book
an appointment for
the refill

(To dothis... Perform the following actions... )
Reject a refill To the right of the pending refill request, in the status list, click Denied.
request
Indicate that the To the right of the pending refill request, in the status list, click To Come

In. The EMR adds the patient to your front end staff's Patient’s To Notify
list, and displays a follow-up task window with your name selected in the
Tofield.

On the Follow-ups window, in the Follow-up Reason field, add any
additional details you want to display in the follow-up, and then click Save

& Close IE'

Approve arefill
request as-is

To the right of the pending refill request, in the status list, click Okayed.

Modify a refill
before you
approve it

-

Inlist of refill requests, click the medication name. The prescription
displays in the Prescription Refill window.

Click Refill. The prescription opens in the Prescriptions window.

Enter and/or edit quantity and duration details as needed.

Note: If youwant to edit dosage and frequency
directions, at the top of the Prescriptions window, click

Edit Medication Dosing = . The Add New Medication
window opens.

»

Click Save &Closel L L . The EMR displays a dialog box with the
following prompt: “Save [last medication name and prescription details}
on prescription?.”

Click Yes. The EMR displays a dialog box with the following prompt: “Print
Prescription”?”

To print the prescription, click Yes: otherwise, click No.

In the Refill Requests window, beside the edited refill, in the status list,
click Okayed. )

3. Afteryoufinish responding to each of the refill requests, click Save & Close | A | The refill
requests are removed from your list and your front-end staff are notified of the status changes.
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Managing pharmacy callbacks using the Pharmacies to Call list (front-end staff)

When you send a refill request to a provider, you wait until the provider approves or denies the refill
before you call the pharmacy. You can track which pharmacies are ready to be called using the
Pharmacies to Call list. From this list, you can:

View statuses (okayed, denied, or pending) of each refill request

Cancel refill requests (if they have not been approved or declined)

Indicate that you have called the pharmacy or patient who requested a refill

Print prescription request reports

Print prescriptions (if it has been approved by a provider)

Steps
1.

2.

Onyour WorkDesk, in the Clinic Tasks area, click <#> pharmacies to call (where # = the number
of phamacies you need to call). The Pharmacies to Call list opens.

Pharamacies to Call

Phammacies to Call

Fesfill Log GP'::; = |E|_¢|

Practitionsr EMer: <<ALL>>

Phamacies To Call |
Caniral care Phammacy  (403)-255-3866
el Drug A0S0

[=] Prescription Refills:

¥ Test, Emmy Janina Somer Schredber, MO PO FRCPC

Insulin (Hurnulin B} 200 5C g am 42 Rl

Denied
®  Medication note

EditPrint | Done

Test, Emimy Janna Somer Schreiber, MD PhD FRCPC
FCOOHIUEWDQ (Pulmécart Turbohaler) 200 mocg | inhalation B0 # R x0

Okayed
e Medication nme

Edit/Print | Done

Inthe Practitioner list, select the provider you want to manage refill requests for, orto view refill

requests for all providers, leave <<ALL>> selected.

To view a list of queued prescriptions for a specific pharmacy, in the left pane, click the pharmacy.
The right pane displays the patients requiring refills and their prescription information. The status

of the refill request appears inred text. A status of:

Okayed: Indicates the provider has approved the refill request

Denied: Indicates the provider has denied the refill request

Pending: Indicates the provider has not yet responded to the refill request

o1
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4. Using the following table, update or complete each of the refill requests.

(To dothis... Perform the following action(s)
Remove (cancel) a refill You can remove only refill requests in a state of Pending (ie.
request (and also remove providerhas not yet responded).
from the provider's list)

Beside the refill request, click Done. Whenyou close the
Phamacies to Call list, the refill request is permanently removed
from the list, and from the provider's list.

Edit a refill request Beside the refill request, click Edit/Print. The refill opens inthe
Prescriptions window.

Edit the Quantity, Repeats, and Duration information as needed,
orto edit the prescription frequency or dose, click Edit

Medication Dosing =

Whenyou are done editing, click Close & Savel A :

Indicate that you have Only refill requests in a state of Okayed or Denied can be marked
notified the pharmacythat | as called.
the prescription(s) have

Beside a refill request in a state of Okayed or Denied, click Done.

been approved or denied The refill requestis removed from the list. In the Réfill Log, the
refill is marked as Called.
Print a Telephone Inthe left pane, select the pharmacy you want to produce a letter
Prescription Refill response | for.
letter for the phamacy At the top of the window, click one of the following options:
m Quick Print Frr : To print the letter from your default printer.
= Print Report 2 : To print the letter from a selected printer.
The status of the refill request is changed to Printed.
To finish the refill request (move the refill request to the Refill Log),
click Done.
Print an approved Beside the refill request, click Edit/Print. The refill opens inthe
prescription Prescriptions window. You can now print the prescription as
normal. See "Creating basic prescriptions" onpage 6 in
9 "Creating basic prescriptions" on page 6. )

5. Toview any refill requests that were managed in the past 4 days, at the top of the Pharmacies to
Call window, click Refill Log.

6. When you finish managing your refill requests, clickl L L :
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Configuring features around medications and prescriptions (legacy)

You can customize a number of features around medications and prescriptions. You can:

Add, modify orremove pharmacies in your pharmacy list (see "Managing your clinic’s pharmacy
list" below)

Configure if and how medication interaction wamings are to display when you prescribe
medications (see "Configuring medication preferences " on the next page)

Set defaults for medication search options (see "Configuring medication preferences " on the
next page)

Set defaults for enabling medication substitutions (see "Configuring medication preferences " on
the next page)

Set what medications are to print on prescriptions (all medications vs. medications prescribed by
a selected provider) (see "Setting what medications to print on prescriptions” on page 57)

Modify prescription defaults for medications (see "Modifying prescription defaults for
medications" on page 58)

Choose to either include or hide patient medication lists on prescription printouts (see "Setting
prescription printouts to include patient medication lists by default" on page 61)

Add custom treatments to the medication list (see "Adding custom treatments to the medication
list" on page 63)

Managing your clinic’s pharmacy list

You access the pharmacy list when you create a refill request, when you set a patient’s default
pharmacy or when you select a pharmacy for a prescription. The pharmacy listis also a handy
reference of all of the pharmacies that your clinic uses. You can access this list to look up pharmacy
contact information, such as a fax number. Any user can add, modify or remove pharmacies via their
WorkDesk menu.

Steps

1.

Onyour WorkDesk menu, click Reference > Pharmacy/Facility List ii . The Facility Information
window opens.

In the Facility Type list, select Pharmacy.

To view and/or modify a pharmacy, in the Choose Pharmacy field, begin typing the pharmacy
name and then, in the list of matching pharmacies, click the pharmacy. You can now modify
informationin any of the entry fields.
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Registration

Pharmacy List g | wC | e

Facilty Type  Pharmacy ? Choose Pharmacy. shopper's drugmart -

Hame: shopper's drugmard Dispenses Drugs:
Strest Lins 1 Misirket Maill

Straet Line 2

Ciby:

Province:;

[Paostal

Office 1111111111

Fao: 222-222-7222

E-ai:

4. To delete the pharmacy, click oS :

5. Toaddaphamacy:

a) Click “ | The EMR displays an empty pharmacy form.

p)  Atminimum, enter information in the Name, City, and Fax fields.

6. Whenyou're finished adding and modifying pharmacies, clickl A :

Configuring medication preferences

You can configure default medication preferences for searching, enabling substitutions, and
interaction wamings

Note: Only users with administrator authority in Wolf EMR can set clinic-wide defaults.
# Providers can set their own defaults, which overwrite the clinic defaults.

Medication search options

\When users prescribe or enter medications in patient charts, you can set what medication search
options are selected by default. You can also choose if medication search matches caninclude
medications that are similar to the search term, even though they may not start with or contain the
exact text entered.




Enabling substitutions

By default, the May Substitute Generic
change the default to instead select the

Steps

1.
Preferences window opens.
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optionis selected by default when prescribing. You can
No Substitutions option by default.

From the WorkDesk menu, click Configure > Configure Workdesk = . The WorkDesk User

Preferences.

&
Q Tip: Foradministrators, from the Wolf EMR home tab, click Configuration C R
- Runtime Configuration tab, and then, at the bottom of the window, click WorkDesk

5 WorkDesk User Preferences

WorkDesk Preferences for Clinic

o)==
v

Documert Template

General T Spel Check T Message TM\SCE\IEnEuuS T

& Drawings FDMEFST Medications! T Graph T Wisit Exams: I Reterrals T Fallow U

hedication search

Use partial match for medication search
Degree of similarity for partial search
Include Generics in search

Include OTC in search

Include I in search

Pull Units from Medication
definition when Multi-select
refill

Print Presctiptions for
Todays Date (per patient)

Default Rx status for
MOA,

Clinic Setting

Contains 2

I

High A
r
r
r

Mever 2

[BLL Ry crested regardess of Frovicer ssiected trom Prescrioing MD st v |

El

| <Pentinge= trom Wesication Refills' and <Printed= from any ofher screen

Click the Medications tab.

To set default medication search opt

ions, use the following table to choose an option. If you are

setting preferences for yourself, clear the Apply Clinic Setting check box beside any options you

are modifying.
*Ra
(®) Total Dosage Per Day: [] Auto save medcation s favourte on exi
Search [ Inchuste Ggneric
(0 Sterts "'*“'; il [ elude OTC
| (= Contsinz <Ay ll [ I Nf
Favourtes Diruig Calegory Sesrch Search by ATC calegories
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(To set adefault for the following option... Do this... )
Starts with vs Contains In the Medication search
list, select the option you
want selected by defaullt.
Whether medication search matches can include medication Selector clear the Use
names that are similar to the search term but don't necessarily | partial match for
start with or contain the exact search term medication search check
DOX.
How similar medication names must be to be included in In the Degree of similarity for
search matches partial search list, selecta
level.
Include Generic Select or clear the Include
Generics in search check
DOX.
Include OTC Select or clear the Include
OTCin search check box.
Include IV Select or clear the Include IV
L in search check box. )

4. Choose your "allow substitutions" preference:

m Clearthe Allow Substitutions Default check box to have the No Substitutions option
selected by default when prescribing.

m Selectthe Allow Substitutions Default check box to have the May Substitute Generic
option selected by default when prescribing.

5. To setinteraction wamings, beside Multum Drug Interaction, clear the Apply Clinic Setting
checkbox and then, inthe list, select one of the following options:
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_ 1 B — T — 1 — ngmﬂrg;";g; N L
User Setting ’:ﬁﬁg
Setting
Medication search ontains L
Uze partial match for medication search 2
Degree of similanty for partial search High i
Include Generics in search L
Include OTE in search Fl
Include I+ in search ¥
Mlulturm Drug Interaction Always On = ]
Pull Units from Medication m @
definition when Mult-select Mhways OF R
refill Manual
Print Presrripliuns Fc" ALL Fx erested regardess of Provider selected from Prescribing MD st | ALL R
g . . . . . N
Option | When the EMR identifies interactions...
Always | The EMR checks for interactions, and if any are found, you receive a pop-up
On notification. When selected, the Multum button is not available.
Always | The EMR does not check forinteractions, and you receive no wamings. When
Off selected, you cannot manually check if there are any interaction wamings. The
Multum button is not available.
Manual | The EMR checks forinteractions, but does not notify you automatically. Instead, you
L can view any interaction wamings by clicking the Multum button. )

6. Click Save settings and exit Ll .

Setting what medications to print on prescriptions

When a patient is prescribed more than one medicationin a day, you can choose:

m if all medications prescribed that day, even if several providers prescribed medications, are to
display on prescription printouts, or

m if all medications prescribed that day by a certain provider are to display on prescription printouts.

Steps

1. Perform one of the following actions:

m [fyouare setting defaults for yourself, at the top of the WorkDesk window, click the Configure

menu, and then choose Configure Workdesk &2 .
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m [fyou are setting defaults for the entire clinic, from the Wolf EMR home tab, click

&
Configuration % From the Runtime Configuration tab, at the bottom of the window, click
WorkDesk Preferences.

2. Onthe WorkDesk Preferences window, click the Medications tab.

5| WarkDesk User Preferences (=% EoR (==

WorkDesk Preferences for Clinic L8

T Graph W/ Wistt Exams T Referrals T Follow U

Dacumert Template
General T Spell Check [ Message TM\sce\laneous anwmmldEJ

Clinic Setting

Wedication search Contains =
Use partial match for medication search 2

Degree of similarity for partial search High -
Include Generics in search r

Include OTC in search r

Include I in search r

Pull Units from Medication

definition when Multi-select Never hd

refill

Print Prescriptions for
Todays Date (per patient)

[BLL Rx created regardiess of Frovider sslected from Prescrioing MD list_~ |

Default Rx status for

petay | <Penting trom esication Refils' and <Printeds from eny ofher screen v |

3. Ifyouare setting preferences for yourself, beside Print Prescriptions for Today’s Date (per
patient), clear the Apply Clinic Setting check box.

4. Inthe Print Prescriptions for Today’s Date (per patient) list, select an option.

5. Click Save settings and exitl L L .

Modifying prescription defaults for medications

Fora specific medication, you can set prescription defaults for:

m Dosing

Anticoagulant designation

Freguency
s PRN

Duration

Other Directions

\When you prescribe the medication, no matter what strength you choose, prescription detail fields
are populated automatically with the medication’s defaults. You can then edit the prescription details
as needed, and complete the prescription as normal. Medication prescription defaults can save a
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significant amount of time as prescribers typically only need to modify one ortwo fields each time
they prescribe the medication.

Medication prescription defaults apply only to simple prescriptions. They are not applied to
sequential, concurrent, variable, adjust as directed, or extemal prescriptions. Defaults are set for all
users only. You cannot set different defaults for individual users.

Steps

o
1. From the Wolf EMR home tab, click Configuration cl

2. Inthe Configuration menu, click View > Patient Reference Tables > Medication Index. The
Medication Maintenance window opens.

3. Inthe Search tab, in the Medication Name field, enter part or all of the mediation name, and then
click Search.

4. Inthelist of matching medications, click the medication you want to modify. In the Data tab, the
EMR displays the medication’s default settings.
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5 Medication Maintenance

File  Options

= Search = T Data T Dosage

Medication M ame: |atorvastatin Fill Doorse: I ,,I
Other Mame: ILipitor Fill Guartity: |-|

Trade MName: |Lipitor Adrniir; PO -

Unit Type: Img LI Frequency: ahs -
Quantity Unit: [, | Duration: INoEuthf v|

Manufacturer: IF'alke-Davis UMLS Code: I
Sub Graup: JHMG-Cot reductass inkibitors Muitum Cade: [4014105

Function Class: Iantihyperlipidemic agentsz FRM v
Dirug Farmily: IHMG-CQL‘« reductase inhibitors Arti-Coagulation [~
Indication: IHyperchoIestemlemia, hypertriglycerdemia Mon printable [
Patency: | b arufacturer

Discontinue I2?J’JUH."’2D11
Bark: | Date

SMOMED CT ID: | End Date |2?;Jun,'2|:|1-| E
Internal [D: |53
SHOMED CT Dezcription:

tonoaraph File/URL: _I

Instructions

b ay be taken ar time but evening iz recommended,

Wiew Change
Histor

5. Using the following table, modify the medication’s prescription default settings as needed.

=]
Frobilem: |
Dozage UnitziDose: *Duration: c Ho Curt I:I'I'I’El
T 1 e O *Date Preggribed 18-May-2017 s |
(® Mone a @ nore  [ETHEENEN - Articosouant O e
ﬁ: Manuiaciurer: Pfizer Cansda inc
20 (O I e Incicdfons: Hypeercholesterlemia,
:: ® i SxMay hypertrighyceridemia
o4 Potent
- L2
Qi abh Rank:
Units O i o
a12h Motes:
mg El .D ) ahs HMay be taken any time but evening is
gam recommended.
PO [=] aizh |
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(To set a default value b
for the following field | Do this...
in the prescription
Dosage In the Pill Quantity list, enter the default dose.
Frequency Inthe Frequency list, select the default frequency.
Duration In the Duration list, select either:
= [he default number of days or months
= No Cut Off or<None> to not populate the field with a default
number of days or weeks, and to default the prescription as a
continuous prescription.
If you select a specific number of days orweeks, the prescription
defaults to a short term prescription.
PRN Select the PRN check box, to have PRN selected by default on the
prescription.
Anticoagulation Select the Anti-Coagulation check box, to have the Anticoagulation
check box selected by default on the prescription.
Notes In the Instructions area, enter the directions you want to display by
defaultin the Other Directions field of the prescription (for example,
L “May be taken any time but evening is recommended”) )

6. Click Save Changes .

Setting prescription printouts to include patient medication lists by default

If you have administrator authority in Wolf EMR, for each user who prescribes medications, you can

choose if their prescription printouts are to include patient medication lists by default.

61
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RX. L, Jodi 18-May-2017
L]

PHN 39302 Born  06-Mar-2003

Start Date: 18-May-2017
Atorvastatin (Lipitor oral tablet) 10 mg i PO OD #10TAB Repeats: 0

May be taken any time but evening is recommended.

May Substitute Generic Altemative

na, MD PhD FRCPC

Allergies/Adverse Reactions:

Allergy, Mid acute on chronic renal failure (raised serum
Creat

Current Medication List:
Atorvastatin (Lipitor oral tablet) 10 ma 1 PO OD
Topiramate (Topamax) 25 mg ii PO BID
PEG 3350 10 gm po od
Melatonin 5mg PO ghs

Whenyou set medication lists to display on prescription printouts by default, every time the
prescriber creates a prescription, the Print Mediations check box is automatically selected.

If the prescriber does not want the medication list to be included on a prescription print-out, they can
choose to clear the Print Medications check box. This setting is user-specific, so you must enable
ordisable it for each prescriber individually.

Steps

&
1. From the Wolf EMR home tab, click Configuration cl

2. Inthe Configuration menu, click View > Physicians/Service Providers > Office Service
Providers. The Physicians/Service Providers in Clinic window opens.

3. Inthe Office Service Provider list, select the provider you want to enable/disable prescription
medication lists for.

4. Inthe Other Datatab, in the Prescription Options area, select or clear the Print Medications on
Rx check box.
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Office Service Provider:

Mame / Addrefs  Other Data ] Bompany / Bank ] Locum ‘waork Coverage ] Billinq] Skills ] Security ] PCR ] ePrescribe ]

Usage Metrics

Perzonal Locum Information Investigation Codes
Change Password | For Service Provider: 2001914 [Lab 1D

Last Change |4 3/Jun/2013 | j

Appointment Style Primary Hozpital

Data Share Address

Long Lengthy] 30 min -

v Callect

Length: |15 min j |<N0ne> j Edit Codes

Prescription Options

Patients per Appointment; 1
Time Definition Type

[w Uses Appt Sche

Start: 01/5ep/2008 Start: 01 Alan/2010 [ Print Border

Up Te: Up Te: ,7 |— Entra Lines
Portr it -

[~ Mon-Prescriber

" Out of Office Hours W Uses 'wiolf Wark D Iv¥ Print Medications on Rx
f* Office Hours v Accept HL7 Data
v Data Share Enabled
[ Walkein Physician ¥ Include in Reporting
wiorking in Clinic Usze of Online Records Dapsheet Report

Default 4ppt Reason

Search
-

5. ClickSave .

Adding custom treatments to the medication list

If you regularly prescribe treatments that are not in Wolf EMR’s medication database (Multum), you
can add these treatments to the medication list. This is most commonly used for non-medication
treatments such as physiotherapy, diaphragms, and crutches. After a custom treatment is added to
the medication list, when you type the treatment name in the Search field on the Add New Medication

window, the treatment displays as an option in the resullts.
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“Rx

() Total Dosage Per Day O Auto save medication &5 favourite on exit

Search O Inchude Generic

. {0 Starts with Doze form [ Incaue OTC
(Phﬁd ] (@) Contains <Ay m [ Inchude '
Fevauriies Crug Category Search | Search by ATC categories
Description
Rz Harrje Favourite Description | Durat

Select ication from list

Genericiame
LYP solltion
LYP soltion
LVP soljtion
i ical irrigating

physi ical irrigating sohtion
physioliical irrigating sohstion

o sohudion
Physiotherapy

Trache Harme

Physionesl 4 with 3.06% Dextrose
Physionesl 4 with 2.27% Dextrose
Physioneal # with 1.36% Dextrose
Lactated Ringers hrrigation
Plegisol

Tis-1-Sal

Urologic G

Dose Form Desage Lird
SOLN
SOLN
SOLN @ Mo @
SOLN
SOLN ¢
SOLH
SOLH {

Steps

o
1. From the Wolf EMR home tab, click Configuration &

2. From the Configuration menu, click View > Patient Reference Tables > Medication Index. The
Medication Maintenance window opens.

3. Click New Medication Record .

4. Inthe Datatab, in the Medication Name field, enter the prescription name (as you want it to
appear on prescriptions).




Creating prescriptions and managing medications

H
File Options
&1
= Gpach = if Data Y Dosage
Medication Mame: IDianhanlﬂ Pil Do I =
T f Pl Quaniy: [~
Tiade Mame | Adrirc | -
Lirk Type: I vI Erequency: I =
Quantity Unit |<Nm9> x| Dueatice: Im -
Manufachres: | UMLE Code: |
Sub Grioug! | Multum Code: |
Eunction Class: | FRN [
Drug Famib: | AntiCoaguation [~
|ndication: | Mon printable [~
Puatency: I arwifachurer
| Discorfirwe |
Bark: | Date
SNOMED CT 1D | End Date | .Ij
Irreanal ID: I
SMOMED CT Desciiplion
bionagraph Fie/URL: | _I
Instnachions
View Change
Hishor

5. Optionally, enter any default prescription details. See step 5 in "Modifying prescription defaults
formedications" onpage 58.

6. Click Save Changes .
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